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A\ ALCHEMEX.

TOOLBARS

1. How to add Macros into your toolbar.

a. From the Menu bar select Tools, Customise .
b. Selectthe Commands tab.
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In the list of Categories , select Macros .

The macro should then appear in the Commands list.

In the Commands list, select Custom Button and drag the button onto the toolbar.
To assign the macro, select Modify Selection and select Assign Macro .

Select the desired Macro from the list and select OK.
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2. How to get your Toolbar back to Microsoft Excel’ s default layout.
a. From the Menu bar select Tools, Customise .

b. Select the Toolbars tab.
c. Select the Toolbar you would like to reset.
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d. Select Reset.

www.alchemex.com




A\ ALCHEMEX.

NAVIGATING

3. How to navigate to different sheets in a workboo  k with many sheets.

a. Right click on the sheet arrows at the bottom left of your screen.

13

14 Shest1

12 Shest2

= ;Sifetzu Sheet Arrows

b. A list of the sheets in the file will be displayed.
c. Leftclick on the sheet name you would like to navigate to.

4. There are two ways to quickly select a row
a. Select the row number.

OR
b. Select any cell in that row and press Shift+Space bar.

www.alchemex.com




A\ ALCHEMEX.

PIVOTTABLE

5. To maintain formatting when refreshing PivotTabl es one must:

a. Format the PivotTable in whatever way you want.
b. On the PivotTable toolbar, select Table Options from the menu.
c. The PivotTable Options dialogue box is displayed.
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d. Make sure the Preserve formatting check box is selected.
e. Select OK.
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A\ ALCHEMEX.

6. The size of an Excel file increases when a Pivot Table is included. To reduce the file size one mus t
do the following:

PivotTables by default always save the actual data with the layout of the table and this causes the increase
in the size of the file. You can however change this on the table options of the PivotTable. Once you have
changed this, you will always have to refresh the table before you can use it.

a. Right click anywhere on the PivotTable .

b. Select Table Options from the shortcut menu.

c. Clear the checkbox towards the bottom of the options window "save
data with table layout".

[PeciTobinl
ko = =
Foo. '
F:.- Foo o oo |—
F'... = r L
[ Work Tosk wih *
r.l. '=.-.: rmm Save Data with
F:. : [ B mar g Table Layout
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R =

d. Select OK, and then save the file. The file should have reduced in size.
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A\ ALCHEMEX.

7. How to group your dates into Months or Quarters in a PivotTable.
This can be easily done by using the Grouping feature in the PivotTable.

Select the field (Date) you wish to group.

Right click and select Group and Show Detail .

Select Group.

The grouping dialogue box appears displaying dates and times.

Grouping m

Aubo
[v Starting at: |23f03f200?
v Ending at: |29{'D4f200?

coop

h
Murnber of days: |1 5‘
Ok I Cancel |

Type the starting and ending information in the fields provided.

Select the option you wish to group by in the By list

Select OK.

Group dates will only work if you have NOT got blank cells selected in the source data. If you do have
blank cells selected, please re-select the area.

Qo
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FUNCTIONS

8. There is a function in Excel called "weeknum" wh ich determines the number of the week within the
year. This is not a standard function; it is only available if you use the Excel Add-Ins ‘Analysis
Tool-Pak'.

a. Selectthe Tools menu.
b. Select add-ins . The add-ins box will display.
c. Select the check box next to Analysis Tool-Pak .

Add-Ins 2| x|

Add-Ins available:

Ml 2nalysis ToolPak —
[ analysis ToolPak - YBA -
[ conditional Surn YWizard Cancel |
[ Euro Currency Tools

[ Internet Assistant VBA AEEE |
[ Lookup Wizard —

[ Solver add-in P — |

T ] Analysis Tool-pak

[

—Analysis ToolPak

Provides functions and interfaces for financial and
scientific data analysis

d. Select OK.
e. The function Weeknum should now be available in the data and time category of functions.

www.alchemex.com




A\ ALCHEMEX.

9. If you have values in the cells D2 through to D1 044 and you want to create a formula in column E

and quickly copy the formula from E2 through to E10 44, try this:

a. Enter your formula into cell E3

A | B | ¢ | D | E |
1 Branch SalesPerson Quantity UnitPrice ProductSales
2 |East Coast Anderson. P £0 ?_20| 432_00!
3 |East Coast Johnson. A 21 13.80
4 |East Coast Feters. K 40 11.20
S |East Coast Bonders. P 2 1470
£ |East Coast Mewson. L 5 15.20

b. Place your mouse on the bottom right corner of cell E1 and double click on the Autofill handle.

c. The formula will then be copied down to cell E1044

d. By double clicking it will automatically fill the range down to where there is data on the left in Column

A. You can also use this for copying formula down.
10. To count the number of cells containing data yo  u can do the following.

Use the correct count function:

e Count: Counts the number of cells containing numbers, as well as numbers within the list of

arguments.

e Count A: Counts the number of cells that are not empty, as well as the values within the list of

arguments.
e CountBlank: Counts empty cells in a specified range of cells
e CountlF: Counts using criteria

See screenshot below:

Text/Number Result Criteria Formulas Syntax

2 9 =COUNT(AA)
4 13 =COUNTALA:A)
(5] B5523 =COUNTBLAMNKA:A)
3 8 Y =COUNTIF (AA,CB)
5 4 * =COUNTIF{A-ACT)
7 3 11 =COUNTIF{AA,CS)
1 3 Ar =COUNTIF(AA,CH)
1 1 *ch™  =COUNTIF(AA,C10)
1 1 29? =COUNTIF(A-AC11)
AAA

A

Alchemex

11. How to calculate the number of month’s service for an employee.

www.alchemex.com




A\ ALCHEMEX.

Use the "DATEDIF" function

a.

The date employed is in cell A2 and the current date is in cell B2.

A |

B | C

1
2

Date Employed Current Date Months

20M1/2005

28M1/2007

Select cell C2 and enter = (DATEDIF(A2,B2,"Y")*12)+DATEDIF(A2,B2,"YM")
Format to number.

2 -

#& = (DATEDIF(AZ B2,"Y")"12)+DATEDIF(AZ B2,"YMW")

A |

B [ ¢ | o | e | F |

1

2

Date Employed Current Date Months

20/11/2005

28/11/2007 | 24|

12. To separate a column of mixed positive and nega tive figures into two different columns the ‘IF’
formula must be used.

a.

o0

In your example your data is in A2:A6.

A B | C
1 Positive | MNegative
_2 ] -23
3] 67
4 -90
_5 | 88
6 78

In B2 enter the formula: =IF(A2>=0,A2,"").
In C2 enter the formula: =IF(B2="",A2,"").
Copy the formula down.

A | B | €
1 Fositive |MNegative
2 | -23 -23
3 | 67 67
4 -90 -90
5 88 88
6 78 78

www.alchemex.com
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13. You

A\ ALCHEMEX.

can format telephone numbers to look a cert  ain way e.g 213456543 to (021) 345-6543. You can

do this by using a combination of Text functions.

A B |

13

14

Original Formatted
Telephone Telephone
Number  Number
218642603 (021) 864-2603

="("&"0"&LEFT(A14,2)&")'&" "&MID(A14,3,3)&"-"&MID(A14,6,15)

Explanation:

a. In-between the " is the additional text such as - ().

b. The & symbol is joining the items together.

c. The LEFT is to extract the first 2 digits (area code) — 21.

d. The first MID is to extract from the 3rd digit and 3 digits after that — 864.

e. The second MID is to extract from the 6th digit and 15 digits after that — 2603.

f.  Al4 is the cell where the original telephone number is, if necessary change that cell reference to

where your first telephone number is and copy the formula down.
Simply copy and paste this formula to the relevant cell, ensuring you change the cell reference Al4 to
whichever cell your telephone number is in.

14. How to format a number without decimal places, with a thousands separator, and combine it with

text,

using custom formatting and joining cells.

For example, Cell A1 contains "You owe" and cell B1 contains the value 87777.

In cell C1 enter the following formula =A1&" "&TEXT(B1,"R#,##0").

1 - A =A1E" "ETEXATIEN, "R 40"

A | B C D | E |

You owe 87777 You owe RB7, 777

www.alchemex.com 11




15.

16.

A\ ALCHEMEX.

A formula can be used to work out somebody'sag e

A person's age is the amount of time since they were born. To calculate their age, put today's date in one

cell and the person's date of birth in another cell, then take their date of birth away from today and you get
their age - right? Well, sort of... you get a number. Because you took a date serial from another date serial
you get the number of days in between.

In this example the formula in cell A3 is:
=Al-A2

A | B

15/08/00 Today

27/09/50 Date of Birth
18220 Age

(=S W W

We need to convert this number of days into a number of years. Most years have 365 days but every fourth
year has 366 days. So the average number of years is 365.25.

In this example the formula in cell A3 is:
=(A1-A2)/365.25

A | B
15/08/00 Today
27/09/50 Date of Birth

49 653641 Age

= Lk =

Note the brackets around the first part of the formula. Brackets mean "Work out this bit first...” They are
used stop Microsoft Excel trying to divide A2 by 365.25 before taking it away from Al. The number is now
in years, but it's still not quite right. The result is accurate but don't really want to see the fraction. As a last
refinement we'll wrap the whole thing inside an INT() function to give us a whole number (an integer). This
is better than changing the number of decimal places displayed, which would risk some numbers being
rounded up and giving an incorrect result.

In this example the formula in cell A3 is:
=INT((A1-A2)/365.25)
A | B
| 150800 Today

1
2 | 27108/50 Date of Birth
3 49 Age

There is no Average IF function in Excel 2003 b  ut you can create your own Average IF using a CSE.

An array formula (CSE) can perform multiple calculations and then return either a single result or multiple
results. Array formulas act on two or more sets of values known as array arguments. Each array argument
must have the same number of rows and columns. You create array formulas in the same way that you

www.alchemex.com 12




A\ ALCHEMEX.

create other formulas, except you press CTRL+SHIFT+ENTER to enter the formula. You will notice that by
using CTRL+SHIFT+ENTER it adds curvy brackets around the formula. This is what makes it a CSE
formula.

Process: See the example below:

B18 - B [=AVERAGE(IF(BAFZ BAF14=A18 C2C14))}
A .8 | ¢ | D | E |

1 [Region Date WValue
2 |Morth Coast 0101086 12000
3 |Morth Coast 1240306 23500
4 |East Coast 23/03/06 14500
5 |Morth Coast 15/04,06 14500
B |¥West Coast 10/05,/06 16700
7 |East Coast 21/05/06 14000
8 |WWest Coast 13/06,/06 23000
9 |East Coast 2B6/06/06 10000
10 |WWest Coast 05/07/06 22000
11 |East Coast 12/08/06 17000
12 |East Coast 22/08/06 23890
13 |East Coast 220006 35000
14 West Coast 1041006 13400
15
16
17 |Average of Values:
18 |East Coast 120651
19 |WWest Coast 10250
20 |Morth Coast T 14333
21

www.alchemex.com 13




A\ ALCHEMEX.

CHARTS

17.

18.

19.

Going through the ChartWizard can take a while.  To put a chart into your workbook quickly, you
can follow these two simple steps:

a. Select the table on which the chart is to be based.
b. Press F11.

That's It! Excel inserts a new Chart worksheet before the current worksheet, and bases the chart on
the data in your table and the default chart type you have set up. At this point you can perform
whatever customisation you desire on the chart and work with it as normal.

If you want to create a Chart that has bothal ine series and a column series plotted on the same
Chart, a Custom Types chart must be used.

If the Chart is already created:

Right click on the chart you have created (on the chart area).
Select Chart Types.

Select Custom Types.

Select Line -column.

Select OK.

©ooop

If you are creating a new Chart:

a. Select the area you would like to Chart.

b. Select the Chart Wizard button on the Standard toolbar.

c. Select the Heading tab, Custom Types.

d. Select Line-column.

e. Complete the rest of the Chart Wizard.

Using a Chart Title that is linked to your work  sheet enables you to simply update your worksheet

and your Chart Title will automatically update.

a. Create the chart as you would normally do.
b. Select the title you want to modify. Small handles should appear around the title.

c. Inthe formula bar enter the address of the cell you want to use for the title. For instance, if the title is in

cell A5 of the Data worksheet, you would enter the following in the formula bar:

=Datal$A$6

www.alchemex.com




A\ ALCHEMEX.

FILTERING

20. To quickly filter a list to summarise informati on, Filtering in Excel can be used.

a. Select anywhere in the list.
b. On the Menu bar, select Data, Filter, Auto filter .
A |

Branch [+~— Drop down arrow
Sort Ascending
Sart Descending

{Tap 10..0
(Custom...)
East Coast
MNorth Coast
South Coast
\Wiest Coast

c. Usethe drop down arrows to filter your list.

|| | e | —

[s:e]

21. If the same list of items is continually used, the easy way to insert the list without having to r e-type
it all the time is by using an AUTOFILL LIST.

Select Tools , Options then select the Custom Lists tab.

Type the first item in the List Entries box and enter.

Type the rest of your items pressing enter after each one except the last one.

Select OK.

To use the list, enter any of the items in a cell then drag the cells Autofill handle (bottom right hand
corner) down or across.

©ooop

22.You can extract a list of unique items, from a list, by using the Advanced Filter.

a. Select the worksheet where you would like the extracted list to appear.
b. On the Menu bar select Data, Filter Autofilter.

Action

(" Eilter the list, in-place

(® Copy to another location .
Copy to another Location

List range: |shestzisate sag17 |
Criteria range: I | —— List Range
Copy to: ISheet‘E!$F$2 E
! —— CopyTo
oK | Cancel —4 Unique Records Only

c. Select Copy to another location.

d. Inthe List range , select the list of items that you are extracting unique records from.

e. Inthe Copy to, select the first cell in the range that you would like to have your results showing.
f. Select the check box for Unique records only. Select OK.

www.alchemex.com 15




A\ ALCHEMEX.

FORMATTING

23. To remove ALL spaces from a cell (as the TRIM f
Replace must be used.

unction leaves one space in the middle), Find and

a. Select the range of cells you would like to remove the space from.
b. Press Ctrl + H.
c. Click on the Find What box and press the space bar once.
d. Ensure the Replace with box has nothing in it.
e. Select Replace all.
24.If you receive data in one column and you need  to extract the data into different columns, you can

do this by using the ‘Text to Columns’ wizard.

a. Select the cells that contain the text or values.
A B
1 |Account Sub Account
2 100300
3 10014001
4 0/200
5 |2004300
b. Onthe Menu bar, select, Data, Text to Columns, Next.
c. Select the Delimiter that separates the items.
d. Select Finish .
A ] B |
| 1 |Account Sub Account
[ 2] 100 300
| 3] 1001 4001
| 4 | 10 200
| 5] 200 300

www.alchemex.com
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A\ ALCHEMEX.

25. To change a font type to Sentence case in Micro  soft Excel, VB code must be inserted to the
worksheet.

Open the required workbook.
Right click on any worksheet.
Select View Code.

On the left, select This workbook.

ooop

On the right side paste the below coding:
Sub Textlt_Click()

'‘Modified Text converter
' Option to select range of cells or correct entire worksheet.

Dim TextCaseAlch As Range
Set TextCaseAlch = Selection.SpecialCells(xICellTypeConstants, 2)

For Each cell In TextCaseAlch.Cells
s = cell.Value

Start = True
Fori=1To Len(s)
ch = Mid(s, i, 1)
Select Case ch
Case "."

Start = True

Case "I"

Start = True

Case "?"

Start = True

Case"a"To "z

If Start Then ch = UCase(ch): Start = False
Case "A" To "Z"

If Start Then Start = False Else ch = LCase(
End Select

Mid(s, i, 1) = ch

Next

cell.vValue = s

Next

End Sub

26. To quickly format from one cell to a range of ¢ ells, FORMAT PAINTER should be used.

www.alchemex.com
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A\ ALCHEMEX.

Select the cell or range that contains the formats you wish to copy.

Select the Format Painter icon. (the yellow paintbrush icon on the Standard toolbar)

Click and drag the mouse over the range you want to paint - Excel then applies the copied formats to
the selected cells and automatically deactivates the painter.

If you need to copy formats to a range or multiple cells, double-click the Format Painter to keep it
active. Pressing the Esc key deactivates the painter once finished.

27. By pressing Alt-Enter you force a new line with  in a cell.

Press F2 to edit a cell
Type the text you need on the first line
Press Alt-Enter, and then type again.

The contents of your cell are split onto 2 lines regardless of the width of the column. Some people use
wrap text to wrap the text onto 2 lines but this is not a permanent format since the text will adjust
accordingly when you widen the column and you could easily end up with the text on one line again.

www.alchemex.com 18




A\ ALCHEMEX.

28. To get numbers to display as only thousands or millions, you change the number format of the cell.

a. Select the cell/cells to be changed.
A | B |
Amount
3000000
4588900
7866999
5 | 1255590

b. Select Format, Cells , select the Number tab , choose Custom as the category , then in the Type box,
type in as follows:

S FICY OO PN

Garoral . |- |
s by J
Curmency :
ArroaTting F
Corie -
Tima _R*m4M__R*-R4ME__R'e
PercerTiage _U Mt -meH_
Fraction e ; Mt
i T ;T Fa ke
Text oo o
4,0 00N 4,

for thousands enter #,
for millions enter #,,

c. Select OK.
A | B
1 |Amount
2 3
3 5
4 g
5 1

www.alchemex.com 19




A\ ALCHEMEX.

CONDITIONAL FORMATTING

29. To apply conditional formatting to an entire ro  w, fix your cell reference for the column.

You can apply conditional formatting that checks the value in one cell, and applies formatting to other cells,
based on that value. For example, you could colour the entire row in a table, if the values in column E are
over a set value (2000).

A [ B [ C [ D ] E
1 |Category Mame Product Mame Date Month Product Sales
2 |Daing Products Blue Cheesze OR0A2008 Spril st
3 |Dairy Products Blue Cheesze 0H0H2006 | April 1566
4 | Dairy Products Blue Cheesze 0H0H2006 | April 3480
B | Daing Products Cheesze Sticks Q702008 Sporil 4340
E |Dairy Products Cheesze Sticks N0 2006 April 1980
T |Daing Products Blue Cheesze THOH2006 April 1392
a. Select the cells to be formatted (A2:E).
b. From the Menu bar select Format, Conditional Formatting.
c. Enter the below and select OK:
Conditional Formatting m
ondition 1
IFDrmuIa Is j |=$E2>2DDD y

Preview of format 1o use when
A, Eormat...
condition is true:
add == | Delzte... | 0K I Cancel |

d. In this example, the formula is =$E2>2000.

www.alchemex.com 20




A\ ALCHEMEX.

30. If you need to compare two lists and identifyt ~ he items that are different, this can be done by us ing
a combination of Conditional Formatting and the COU NTIF function.

[ | [

=

2

r
-

i’l

a
{3

I T T T TN
[T LTS
Nl [[TI8Y]
I 1K
10005 10002
1 ) 1T
10808 : 10l
TiiLki:d B ILEi.I-
T=] LI -
=] i 2
{Ta]k i
([ B it
1~ 1

Iinr 5
hiera

The first list is in A2:A16 and this range is named newacc. The second list is in D2:D16,and the range is
named oldacc.The ranges were named using the Insert - Name — Define Command. Naming the ranges is
not necessary, but it makes them easier to work with. As you can see, items in newacc that do not appear
in oldacc are highlighted with a blue background. ltems in oldacc that do not appear in newacc are

highlighted with a purple background. These colors are the result of Conditional Formatting.Select the
newacc range.

a.
b.

Qo

On the Menu bar, select Format, Conditional Formatting.
Enter in the below: =COUNTIF(OLDACC,A2)=0.

Conditional Farmatting

Conditicen 1
[Fermua s =] [=2mnmriobiac: 2)=0

Pray e of for mst m Lss wivan
condine B e

T
ASBbCeYyTz | Bermats,
e . T

Select the oldacc range.
On the Menu bar, select Format, Conditional Formatting.
Enter in the below: =COUNTIF(NEWACC,D2)=0.

Conditional Farmatiing

Cond tion 1

m‘ |=CDUNTIF {reveece,D2)=0 =
Praview of format o use when
cordion 18 true; AEBbCO YTz | Earmat..,

gdsr | pelem.. | ok | e |

The COUNTIF function counts the number of times a particular value appears in a range. If the formula
returns O, it means that the item does not appear in the range. Therefore, the conditional formatting
kicks in and the cell's background color is changed.

31. To highlight duplicate items in a column, a com bination of Conditional Formatting and the
=COUNTIF function must be used.

www.alchemex.com 21
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©ooo

A\ ALCHEMEX.

Select the range of cells.
A | B |

Invoice No.
NS890
INW2355
[MNW4180
MWD
[N 1725

7 [INYEE90
On the Menu bar, click on Format, Conditional Formatting.
Under Condition 1, select Formula Is.
In the formula =COUNTIF(column range you are in, cell you are in)>1.
Select Format and select a Pattern of your choice.

T | (L b —

Conditional Formatting B
ondition 1
W v | [=counTIF(a:8,42)>1 Fad
Previgw foormat to use when AaBbCCYyZz Eartiigii. |
condition is rue:

Add == Delete... | Ok I Cancel

Click on OK.

A | B
Invoice No.
[MY5390
(MY 2355
(MY 4180
(Y1071
MNY1725
MY 5390

www.alchemex.com

22




A\ ALCHEMEX.

SHORTCUTS

32. If you have a number of open workbooks and you want to close them all, this can be done by using
the Shift key.

Hold down the Shift key as you select File on the Menu bar.

You will notice that there is a Close All option .

Choose this, and all your workbooks are closed.

You will, of course, be prompted to save changes on each open workbook, if necessary.

oo op

33. To quickly enter today’s date in a cell without having to type the formula =Today (), one candot he
following:

a. To enter the date press CTRL +; (Ctrl and semicolon simultaneously)
b. To enter the time press CTRL+Shift+; (Ctrl, shift colon simultaneously)

A =
1 | Shortcut Result
2 |Cirl+ 051142007
3 |Clrl + Shift + ; 12:00

34. To quickly insert a new worksheet.

a. Select the worksheet to the right of where the new worksheet will be inserted
b. Press Shift+F11

www.alchemex.com 23




A\ ALCHEMEX.

PAGESETUP

35. To use the same printing settings for a number of worksheets, without having to manually setup
each worksheet, you group the worksheets together.

ooop

Select the worksheet whose print settings you want to copy.

Group this worksheet together with the worksheets that need to have the same settings.

From the File menu, select Page Setup, and then select OK.

The page settings from the worksheet selected in step 1 are copied to all of the selected worksheets.

36. When you need to print different ranges for dif ~ ferent departments in the same spreadsheet, create
Custom Views so the settings don't need to be redon e every time.

a.

~ooo0Go

Before defining the print area, hide the rows and columns you do not want to print, and set up the
spreadsheet as desired.

From the View menu, select Custom Views . Select Add.

In the Add View dialog box, type the name of the view in the Name box, and then select OK.
Repeat until all different reports have been customised.

From any worksheet in the workbook, select the desired Custom View from the Custom View box.
Press Ctrl+ P. In the Print dialog box , click OK.

37. Use the ‘Remove Page Breaks’ Function when the  page breaks need to be reset.

ooop

Change your view to Page Break Preview.
View, Page Break Preview.

Right click on any cell on the worksheet.
Select Reset All Page Break.

www.alchemex.com
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38.

39.

40.

41.

A\ ALCHEMEX.

To have the word "Confidential" printed on Fina  ncial Statements reports, use WordArt and create a
watermark.

a. Right-click on a toolbar and select the WordArt toolbar from the shortcut.

b. On the WordArt toolbar , select the Insert WordArt icon.

c. From the WordArt Gallery , select your choice of format, and then OK.

d. Inthe WordArt Edit Text dialog box , type Confidential , select the font and size, and then select OK.

e. Right-click the WordAr t, select Format WordArt from the shortcut menu, and then select the Colors
and Lines tab .

f. InFill, select No Fill from the Colour dropdown list.

g. Inthe line section adjust the colour and line format to black.

h. Select OK.

i.  Right-click the WordArt, select Order from the shortcut menu, and then Send to Back.

j- Adjust the WordArt to suit the sheet.

To apply the same ‘Header and Footer’ to some o f the worksheets on a workbook, ‘Group’ (select)

the required sheets together and then create the ‘H  eader and Footer’.

a. Select the worksheets - if the worksheets are adjacent to one another, select the sheet tab of the first
sheet in the range, hold the Shift key then select the last sheet in the range.

b. If the sheets are not adjacent to one another then select the first sheet, hold the Ctrl key, select all
other sheet tabs of the sheets you wish to apply the header and footer to.

c. Select File, Page Setup, Header and Footer.

d. Apply the header and footer.

e. To ungroup the sheets, hold the shift key then click on the first sheet tab within the group.

When you click on a cell which contains a very long formula, it often takes up more than 2 lineso  f
text in the formula bar and it hides the first rows of your spreadsheet. To overcome this insert a
blank row at the top of the worksheet and increase the row height.

a. Toinsert a blank row — Right click on Row 1, then select Insert, Rows.
b. Increase the row height of the new row by selecting, Format, Row, Height , then type in a high number
eg.50

To display two worksheets in a workbook on the screen, at the same time, in order to make it easie r
to complete work - do the following:

a. Open the workbook; activate one of the worksheets you need to display.

b. Select Window, New Window .

c. The workbook will open a second time. In this workbook activate the second sheet you need to
display.

Now select Window, Arrange Windows

e. Tick the check box "Windows of active workbook ", choose the display you want eg tiled, vertical etc.
Select OK.

o

-
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42. To get the heading of the report to be repeated  on each page when it prints, one must set the prin
titles using Page Setup.

a. Select File, Page Setup .
b. Select the heading tab Sheet .
c. Inthe "print titles " section, to have headings repeated; fill in the section "Rows to repeat at top ".

J o Sheet
| 33 | : !
I o Rows to Repeat at
L r:
rk.
r
.
2

|
To have a column of information repeated on each page, fill in "columns to repeat at left".
e. Select OK.

o

43. How to match the name of a worksheettab toac  ell on the worksheet e.g. Al, by adding code to the
Worksheet Module.

a. Select, Tools, Macro, Visual Basic Editor.
b. On the left, in the Project window, select "This Workbook".
c. On the right, in the Code window, paste the below code.

‘all MicTodenl Visued Hader - Book] - [ThisWoskstak {iCoseT)
B Ee Ecn Wow [nesnt Fgmmml Dabug  Hon Todls  Adddne  Window  Help - B
e R | A R L T W
Wk =] [sEeerChange i
= | E Brivate Sub Workbook: SheetChange (EyVal 2h ke Ghiect,
= B EAPenRo {Eaok 1) = IT Target.Addrezs = "SR31T Then Sh.Mans = Target
2 5 liroeat Extn Ok End Sub

M Shaan @la)

W Sheail (Shoetd

M Sheats (Gresed]

B Thiekvorkbook

Private Sub Workshop_SheetChange(ByVal Sh As Object, ByVal Target As Range)
If Target.Address = "$A$1" Then Sh.Name = Target

www.alchemex.com

t

26




d.

End Sub

A ALCHEMEX.

Select, File, Close and Return to Microsoft Excel.
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HYPERLINKS

A\ ALCHEMEX.

44. To open another file from inside a workbook, it is best to use a hyperlink.

d.
e.

Select the cell where you want the link to be activated from.
Right click and select Hyperlink .
Under Link To , select Existing File or Web Page .

Lirk !

it
Egtating F ks or
Wit Face

&
Flace in This
Cocument

Craatn B
[ea i1

_Tast o diiplay: |

E-mail ddchrees Addrges!

— Link To
Lok i 22 ry Document= = 4l A .
= Existing File or Web Page
() Camitags Sk - Bgokmark...
el =
) My Disks Scurces
=0 My Flash Monves
Provwesed 2N Pty MU
Fages | My PrctLres
3 My Rlsceved Fles
4 My Shapes
REGEMtRE | - 1y oeye Contert
" My Shvre Fichres =l
[ =l
| _cmet |

Navigate to the desired file.
Select the desired file and select OK.

45. How to select a hyperlink without activating it

a.
b.

Press and hold the mouse button on the cell for a few seconds.
To select a graphic with a hyperlink, CTRL and click the graphic.

www.alchemex.com
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EXCEL OPTIONS

46. To always show all the menu items and not only the recently used ones, use the ‘Customise’ option
on the tools menu.

47.

ooop

Select Tools, Customise.

Select the Options tab.

Clear the check box "Menus show recently used commands first
Select OK.

You can prevent Excel from prompting you to upd ate links when you open a workbook which
contains links to other workbooks, by changing the settings on the Option screen to have it update
the links automatically.

oo ow

Select Tools, Options.

Select the Edit tab.

Clear the check box Ask to update automatic links.
Select OK.

www.alchemex.com
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SORTING

48. Use SORT to get rid of empty rows in between my  data.

a. Select all columns containing data.
b. From the Standard toolbar, select the Sort Ascending.
c. The empty rows will be sorted to the bottom.

49. If you have a month column, and would like to s ort your months in month order, you will need to
use a custom sort.

a. Select any cell in the month column.
b. From the Menu bar, select Data, Sort.
c. At the bottom left, select Options .

Sort ilil
Sort by
IMDnth LI @ pscanding

Sort Options E

Eirst key sort order

Hanuary, February, March, April, May,

I_ Case sensitive Cancel |

Orientation
® Sort top to bottom
" Sort left to right

Options. .. (]4 Cancel |

d. Select the months as your First key sort order
e. Select OK.
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SUBTOTALS

50. How to subtotal under more than one field by us  ing Subtotals.

a.
b.

@~oao

Sort the fields which you need to have subtotaled.
In the example (see screenshot), Customer Name and Area have been sorted.

Date  Customer Name Area Invoice No Quantity Total |

01-04-05 ABD Co Dbn 2120 454 34 5584.00
10-04-06 ABD Co Dbn 2131 3,333 5 /56 B57.00
0104.06 Joe Bloggs hb
02-04-06 Joe Bloggs Jhb Aiblotal
10-04-05 Joe Bloggs Jhb At each change in:
H1-0A.0E Jabm Brasm b T — =
10-04-08 John Brown Jhb ;
01-04-05 MewCao CPT behmion
01-04-05 "Whittings FE |5um v
02-04-06 Whittings FPE :
04-04-06 Whittings PE oo
01-04-05 ¥Y7 Ltd EL
02-04-05 =% 7 Ltd EL
03-04-085 =Y 7 Ltd EL

Replace current subtotals

[ Page break between groups

surnmary below data

[ Remove All ] [ LS ] l Cancel ]

Select Data then Subtotals .

Make the selection in the At each change in dropdown list, eg. Customer Name.
In Add Subtotal to , select the Quantity and Total checkboxes.

Repeat steps 3 and 4, and select Area.

Deselect the Replace current subtotals checkbox, and then select OK.

Alchemex Contact Information

Sales sales@alchemex.com
Support support@alchemex.net
Website www.alchemex.com
Forum www.alchemex-forum.com
Online Academy www.alchemexacademy.com
Knowledgebase www.alchemex.com
Free Trial Software download www.alchemex.com
Customer References www.alchemex.com

If you know of anyone who will benefit from using A Ichemex - PLEASE contact Sales.
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